SUN - SON
Data Modeler for Notes

Installation and configuration for the Data Modeler for Notes

This document provides an installation and configuration guide for Sun & Son’s Data
Modeler for Notes. The Data Modeler permits Cognos ReportNet or Cognos 8 Bl to access
data held in IBM Lotus Domino Databases. The Data Modeler employs a Notes based,
Graphical Wizard to generate hidden Notes Views and associated XML data models, then
inserts these elements into target Notes databases to be used for Cognos reporting.

Updates in Build 1.002.000:
New configuration options are available in the settings page of the Data Modeler. These
options include “Language”, “Cognos Version”, and disabling “Show Sample Values” for

databases that are not full text indexed.

The Data Modeler for Notes can stage data externally to optimize access to very large
quantities of Notes documents in a secondary repository.

Data Modeler Support for NSFDB2 is now available on a limited availability basis; please
contact support@sunandson.com for more information.

Intended audience for this documentation:

The roles and privileges associated with the installation and configuration of the Data
Modeler for Notes are listed below. They may be attributed to one or more persons
depending on the needs of your organization.

1. Domino Systems Administrator —
8 Access to create databases
Authority to sign databases with Server ID
Ability to create/modify groups in the Domino Directory
Access to delegate IDs used to read and access data for reporting
Set up an ODBC Data Source
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2. Cognos ReportNet or Cognos 8 Bl Administrator —
Ability to set up a Cognos Data Source
8 Ability to install NotesSQL directly on the server that is retrieving data
from Notes Databases.
8 Access to create Projects and Models in Framework Manager and
publish the report Packages
8 Access to create a Test Report in Query Studio

3. Report Designer/Data Modeler —

8 Knowledge of the target Domino Database Application and how data is
stored in it Ability to set up a Cognos Data Source

§ Ability to set up a Cognos Data Source

Designer Access to target Domino databases

8 Access to create Projects and Models in Framework Manager and
publish the report Packages

8 Access to create a create Reports in CRN or Cognos 8

8§ Enhance the Data Structure in Framework Manager

wn
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Components and Prerequisites
Required Components:

Cognos ReportNet or Cognos 8 Bl
Lotus Notes/Domino 6.5 or higher — platform independent
Lotus NotesSQL (3.02g) — must reside on Windows server

Data Modeler for Notes — configuration database supplied as a NSF file
(DataModeler.nsf)

Sample Domino Database “DMSample.nsf” (used in examples presented in this
documentation)

P ONPE
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For details on other types of deployments consult the Data Modeler for Notes Best Practices
Guide.

Cognos ReportNet or Cognos 8 Bl Server Specifics:
1. Install and configure Cognos ReportNet or Cognos 8 Bl on Windows server

2. Install & configure Notes Administrator client 6.5 or later with Admin Notes ID (if not
installed on Administrator Workstation)

3. Install NotesSQL (3.029)
Consult the official Cognos documentation Cognos installation details.

Administrator Workstation Requirements and Prerequisites:
1. Install Cognos Framework Manager
2. Configure Framework Manager to point to CRN server
3. Install and configure Notes Administrator client (if not already installed on Server)

Data Modeler for Notes Installation and Configuration Steps

The remainder of this documentation is dedicated to the following tasks:
A. Install and Register the Data Modeler Database
B. Run the Wizard in the Data Modeler for a target Notes Database
C. Set up an ODBC Data Source
D. Set up a Cognos Data Source
E

Create a Project in Framework Manager and Publish the Data Model Package
to Cognos Connection

Create a Test Report in Query Studio

n

G. Enhance the Data Structure in Framework Manager
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A. Install and register the Data Modeler Database

1. The Data Modeler for Notes is contained in a Notes database which can be installed on a
Domino server or on a local Notes client. This documentation assumes that the database is
installed on the Domino server. Should you choose to install the Data Modeler on a
separate administrative client, consult the Data Modeler Best Practices guide to insure
proper implementation.

Choose an Installation Notes User ID that has rights to create Groups in the Domino
Directory (Public Name and Address Book). Use this ID for the Data Modeler for Notes
installation.

Create a folder named Cognos under the server Data directory and copy the files
“DataModeler.nsf” and “DMSample.nsf” from the Data Modeler for Notes distribution CD to
that folder. (e.g E:\Lotus\Domino\Data\Cognos\DataModeler.nsf where E: is the data drive).
Once copied, right click each file to open the file Properties. Uncheck the “Read-only”
attribute.

General | Security | Surnmary

IDataModeIer.nsf

Type of file:  MSF File

Open: with: |BM Lotus Nates/Domi Change... |

Location: Chlatushnoteshdatatcognos

Size: 1.77 MB 1,857,024 bytes)
Size on disk:  1.77 MB [1,859.584 bytes)

Created: Tueszday, October 18, 2005, 7:16:41 AM
Maodified: Monday, Mavernber 14, 2005, 11:08:45 AM
Accessed: Today, January 03, 2006, 3:20:42 Pk

Attributes:‘ [~ Read-only , Hidden Advanced...l

0K Cancel Apply
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2. Sign the Data Modeler database with the server’s ID. Login to Notes Administrator
Client with Administrator’s ID. Navigate to installation server by clicking Files > Server in
the top menu. Open the Files tab and highlight the Data Modeler database. In the right
pane under Tools, click Database > Sign... Choose the Active Server’s ID, then OK.

Sign Database

B
Uze thiz tool to sign databazes with the
currently active 1D file.

Selected:  busptime.nsf, 923 KB bytes

Which ID do wou want to uze?
T Actipellearz D

& fctive Server's ID

Wwhat da pou want ba zign?

& Al design documents
1 4l data documents

)l documents of type IForm vl
= This specific Mote [ I

[~ Update existing signaturez only [faster)

[atabaze will be signed in the background on the server currently
zelected.

3. In the Notes Administrator’s Client check that the Administrator has rights to access the
server’s Domino Directory (Public Name and Address Book) and has Group creator/modifier
rights.

Open the Domino Directory on the installation server and create the Group “CRNData
Modeler”. Add the names of all the Notes users who will be using the Data Modeler to
configure connections to Notes databases. It is not necessary to add the names of all the
users that will just be viewing data through Cognos. Save the Group document and close
the Directory.

4. Open the Data Modeler for Notes database using the File > Database > Open command
on the install server. If you are prompted to create cross certificate, the database was not
properly signed in step 1 and this step must first be completed before continuing. Bookmark
the database or position it on your Notes Desktop where you can find it later.
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5. When you open the database, you will be presented with the notice of registration. Click
the close button to dismiss this notice.

SUN & SON
Data Modeler

for

Enabled for Cognos

This is Trial Software: you have 30 days remaining in your evaluation period.

You are allowed to install and evaluate this software for thirty (30) days from the
installation of this software. Beyond the thirty day evaluation period yvou agree to
purchase a full license for this software (from Sun & Son or a licensed vendor of
this software) or permanently discontinue using this software or any files generated
by usage of this software, This includes the exported XML Data Models generated
by this software.

By using this software vou acknowledge and accept the “"Data Modeler for MNotes
Enabled for Cognos - Trial Software Agreement” found here,

To purchase a full license for this software contact your vendor or;

Sun & Son

2 Siri Singh Sahib Lane
Espanola, Mew Mexico 87532
phone 505.989,.5000

http:/ www . sunandson.com

6. Next, click on the Register link in the database navigator.

DATA MODELER
for Notes

O New Database Wizard
O Settings

O Notices

SUN,-/SON

—
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7. Enter your information and license key. Your name and email address must match
exactly the information you submitted when you purchased the Data Modeler. Check “I
have read and agree to the terms of the software license”. Click Register.

Q Wielcome ]@iﬂ‘\ Data Maodeler Test - Data Models > { @fh Praduct Registration ¢

Data Modeler for Notes Product Registration

Company Hame |" Company MName 4
Ccase-sensitive

POV EEEBE

Contact Mame "UserMName 4

Contact E-mail "UserName@Domain.com
Ccase-sensitive

License Key T BNV E-RHGE-BEWYWY 4

¥ | have read and agree to the terms in the software license.
Yiew Software License

You have 30 days remaining in your trial period.
Contact us at www.sunandson.com to register this product.

1€ %
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If you have not checked the software agreement box you will get the following error. Check
and resubmit.

1I

Yau must acknowledge that wou have read and agres to the tetms in the software license,

O |

If you have not completed the registration correctly you will receive the following prompt.
Check your registration information to ensure that your name and email address match your
original order information. If this error persists contact your licensed Data Modeler support
center.

1I

Reqistration Failed - please review your registration information,

If you have registered the product correctly you will see a Thank You message.

1I

Thank wou For registering this product.

K |

If you have not purchased a license key, click cancel. You may use the database in
evaluation mode for 30 days.
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8. With the database open, select File >Database > Access Control from the Notes menu.
Add the Administrator’s name to the Access Control list with Manager Access and the right
to ‘delete documents’ checked. Add the Group you created in step 3, CRNData Modeler.
Give the group Editor Access with all additional right boxes checked.

Modify the —Default- entry to No Access. The Data Modeler is shipped with —Default- as
‘Manager’ for installation purposes. Click OK.

Access Control List bo: Data Modeler for Notes X
_"—ﬂ Basics
% Roles People, Servers, Groups IShUw all j Uszer type IUnspecified vl

¥ Log CRMData Modeler

¢l Advanced LocalDomainS ervers
OtherDamains ervers

™ Create documents
I~ Delete documents

™ Create private agents

[" | Create personal folders/views
I™ Create shared folders/views

I™ | Create LotusSerptlaya agents
[~ Read public documents

[ white public documents

I” Feplicate o copy dozuments

Roles

| Add... | | Fename... | | Remove

| Effective Ancess |

Full narne:

An Access Control Ligt (ACL) defines who can view and edit your database.
Select a name in the list to see or get the access assigned to the name.

Lazt change: Mangala Sadhu Sangeet Singh Khalza on

According to: SunandSan 0K I | Cancel

9. The Data Modeler writes hidden views to the Target Domino databases from which you
will be gathering data for Cognos CRN or Cognos 8. For this reason the person running the
Data Modeler must have a minimum of ‘Designer’ access to each Target Domino database.
We recommend adding the CRNData Modeler group with Designer access to the ACL of each
target database. Database processing will not complete if this level of access has not been
set. If your security policy requires, you may remove the group once the Target Database
has been processed.
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Run the Data Modeler Wizard on a Target Notes Database

When the Data Modeler processes a target database, it creates hidden views in the
database and exports an XML file that is referenced by Cognos CRN or Cognos 8.

1.

Open the Data Modeler database, if not currently open. Click “Settings” action or choose

“Settings” from the navigator. You must do this step prior to running the Database Wizard.

&

BEPEcaE

[ ekt JFC4 deworms st - oo | 23] worksguan o[ Dt Worker T et - Dbl el .-
| T Cazm J Musw Dtabaze m:ﬂmﬂ Charge Servar gﬂ Anguatar
MTA HOMER | Databass Prewoert i g
for Notes

o New Dataase Wizard
0 Seffings
0 Motices

O Register

SUN -—/SON

2. Verify or override the default configuration and click “Save and Close”.

Cognos Version — Select the version of Cognos you will be creating data models for.
Changing this setting allows you to rerun existing data models for different versions of
Cognos.

XML Model Export Path - The default path is C:\temp, if the path does not exist it will
created.

Show Sample Values — When set to Yes, preview data will be displayed to assist you in
selecting fields to be used in the data model. A Notes full text index is required to
display these sample values. If you will be creating a data model of a Notes database
that does NOT have a full text index or slow performance on updating views you wish to
set this to “No”.

Data Modeler Configuration

fyou may want to disable
this if performance is
slow when loading step 3
of the wizard.)

Cognos VYersion: @ Coghos ReportMet € Cognos 8 BI
Language: [English 1J5) -

XML Model Export TCMempy

Path:

Show Sample Values: | © Yes & No
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3. Click the “New Database Wizard” action button to begin processing for a Notes database.
< g Mews Databaze Wizara >@* Settings

%Close
"~ Tpau

4. At the Step 1 of 4 screen, click the “Select Database” button to select a database.
Wizard Step 1 of 4

Database: [ Select Databhase ..

Packaye Name: I

Connection Name: I

[T We will be staging data externally

Cancel l [ MNext

10
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5. Select a database using the Choose Database dialog. The database can be located on
local or on any server you have access to.

Choose Database X |
Server | Open |
IAngad.-’Sun L Son j -

Database

@ Here are our news product ideas |

@ Sun & Son Propozals
@ Travel & Expenze fichive

@ Travel & Expense Tracking

1 DMS

3 k-Master

1 Praojects

1 Sales

Filename

IS&S\T&Etrack.nsf Browse... |

o

6. Once a database is selected the three fields will be set with default values. The example
above shows the Sample Databases which ship with the product. Package Name and
Connection Name default to the Database name with spaces and other restricted characters
removed. Package Name is a name your users will see when they select Data Packages
from Cognos. Connection Name is the name for the ODBC Data Connection you will create.
You may wish to modify these names for logical grouping of packages or connections. This
is especially true for deployments with multiple packages or multiple uses of the same
database within one deployment. There is no inherent issue with using the default values.
The XML file uses the connection name. However, be careful to remove illegal XML
characters (such as “&”) in the names you use in these fields. Make a note of the names
that you do use. You will be referring back to these names later.

If you do not have Designer access to the Target database, you will be warned when you
click “Next”. You will not be prevented from running the wizard without Designer access to
the target database, but changes will not be written to the target database and the data
collection will not function. You will have to rerun the wizard after modifying the ACL to
actually make the data in the target database available. All of the settings from the previous
run of the wizard will be saved.

I x|
! E ¥ou do not have Designer access to the specified database. You may continue this wizard, buk vou will not be sble o save the custom views to the database.
*

11
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Note: Do not click the check box “We will be staging data externally” unless you are using
this advanced feature. This option allows for data staging to an external DBMS. For more
information on this feature consult the Data Modeler for Notes Best Practices Guide

Click “Next”.

Wizard Step 1 of 4

Database: Select Datahase ..
Local: DMSample nsf

Package Name: IDemuTETracking

Connection Name: IDemDTETracking

[T We will be staging data externally

Cancel M et

7. The Step 2 of 4 screen in the Wizard shows a list of all of the Notes forms defined for the
selected database. Select only those forms that define meaningful data sets which will be

used as Cognos as query subjects. Avoid including all forms in a single database unless all
are significant to the reporting you would like to do.

Select the forms you want to publish by clicking the corresponding check boxes. Click
“Next”.

Wizard Step 2 of 4

Select the forms you would like to include:
SelectAll || SelectNone |

[ ApprovalHelper -
[¥] Expense ltem (Expenseltern)
[ HelperapprBatch

[ Helperapprowval

[] HelperReviewsdmin

[ HelperReviewBudget

[ HelperReviewCorp

[ HelperReviewFinance

[ InvoiceHelper

[ kemo (Mema) T
[[] PaidHelper

[ ReimburseHalpar

[ ReimburseHelperPartial

[[] Reservation =l

Cancel Back Mext

12
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8. The Step 3 of 4 screen presents one screen for each form you selected. You must
complete Step 3 for each form selected in Step 2. In the example below, the Expense Item
form is displayed. The left hand box displays all of the Fields defined on that Form. We wiill
select the Notes Fields we want to expose to Cognos reporting. To the right of each field
name, we show data type and sample values (in parentheses) from randomly selected
documents. A full text index is required for this feature to work. This Feature can be
disabled in the Settings of the Data Modeler database for DBs that don’t have a full text
index or have slow database views.

Select the data elements you want to publish by checking the corresponding check boxes
and click ‘Add’. The selected data elements will show in the right hand box.

Note: The display box shows a list of the Field Names extracted from the design of the
Notes Database and not the corresponding Field Labels that appear to the end user when
using the Notes form or view. For this reason it is important that the person configuring the
connection to the Notes Data is familiar with the source Notes Application.

Note: Rich Text Fields and encrypted fields are not available for selection.
Wizard Step 3 of 4

Current Form: Expenseltem (1 of 1)

Select the fields you would like to include:
SelectAll | | SelectNone |
Add fields frorm: @ Form € Subform

[[] AuthDescrip (Tex)
[ AuthMurn (Text)

[ Authors (OTHER)
[ Billamaunt (Murmber)
[ BillPctg (OTHER)

[ BillTo (OTHER) Add >>

[[] Comments (Tex)
[[] DocAuths (OTHER) << Remaove
[] EnteredBy (Text)

[[] Exp3PPayer (Tex)

[¥] ExpAmount (Mumber

[ ExpCity (Text) —
[¥] ExpDate (DateTime)

[ ExpDescrip (Tex)

[[] ExpMileRate (Number) Edit Mowve Up Maowe Daown
[ Exphiles (Mumber)
[ ExplNum {Text)

| »

[¥] ExpPaidTo (Text) Sort: & Mone " Ascending ¢ Descending
[¥] ExpPrathdeth (Text)
[] ExpReceipt (Text) d Label:

Multivalue: © Yes @& Mo

Apply

Show Advanced Options Cancel Back I Mext I

13
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Note: The button “Show Advanced Options” will allow you to add custom elements or
specify a View Selection Formula that can further constrain the document selection. Consult
the Best Practices Guide for more information on the implementation of this feature.

Edit View Selection Formula:

Default

Form = "Expense ltem" | "Expenseltem”

Hide Advanced Options

9. The Data Modeler creates a special hidden view in the selected database for each form
selected. The view will have a selection formula for that form and column definitions for
each of the selected data elements. The order and sorting of the data elements is designed
to optimize the performance of SQL queries against the database views.

To move a data element (Notes field in this case) up or down, select the data element and
click the “Move Up” or “Move Down”. To sort a data element, select it, click the Ascending
or Descending radio button and click Apply. You will see an indication of sort order in
parentheses next to the data element name, (A) or (D). Sorted data elements should be
moved to the top, so that they become the left-most columns in the created view. Sorts are
additive (Just like in a Notes view).

AlthiNum (A)
Authors
ExpAmount
ExpCity
ExpDate
ExpDescrip
ExpMNum
ExpPaidTo

Edit hdonve Up horve Down

Sort: © Mane & Ascending ¢ Descending
Label:
Multivalue: © Yes & Mo
Apply

14
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10. You may want to show more user-friendly labels for the selected data elements. It is
advised to use the same field labels that the end users are accustomed to seeing in the
Notes Form. To override a data element name (Notes Field name as defined by the
Database Design), select a data element, type the new value under Label and click Apply.
You will see the label in parentheses next to the data element name.

AuthMum (4)
Authors

ExpArmount (Amount)
ExpiCity

ExpDate
ExpDescrip

Exphlum

ExpPaidTo

[ Edit H Mowe Lp H tove Down

Sort: & Mone © Ascending © Descending

Label: I*"'\'””DUnt
Multivalue: T Yes & Mo

15
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11. Entries in a multi-value field will concatenate by default. To show each value of a multi-
value field as a separate row, you must click the Multi-value radio button while the field is

selected and click Apply. This field will then display (M) next to the field name. This also
makes this column sorted ascending.

If you plan on using this feature it is recommended that you consult the Data Modeler for
Notes Best Practices Guide to insure that your implementation produces the intended result.

AuthMurm (A)
Authors
ExpDescrip
Exphum
ExpPaidTo
Edit hove LUp hdone Diown
Sort: % Mone © Ascending € Descending
Label:
Multivalue: & “es & Mo
Apply

16
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12. When finished, click Next. Repeat steps 7 — 11 for each selected form. At any point,
you may select Back to change your configuration before continuing.

Wizard Step 3 of 4

Current Form: Expenseltem (1 of 1)

Select the fields you would like to include:
SelectAll | | SelectNone |
Add fields frarm: & Form  Subform € Custom

[ AuthDescrip (Texd) = AuthNum (4)

[ AuthNurm (Texd) Expurm (&)

¥ Authors (OTHER) ExpAmount (Amount; A)
[ BillAmaount (Mumber) ExplCity (City)

[ BillPcty (OTHER) ExpDate (Date)

[ BillTa (OTHER) Add »> ExpDescrip (Discription
[ Comments (Tex) xpPaidTo (Paid To)

[ DocAuths (OTHER) << Remove
[] EnteredBy (Tex))

[] Exp3PPayer (Tex)

¥ ExpAmaunt (Murnber)

¥ ExpCity (Texd) —
[ ExpDate (DateTime)

¥ ExpDescrip (Text)

[ ExpMileRate (Number) Edit howee LUp Maowve Dawn
[] ExpMiles (Number)
[ ExpMum (Texd)

] ExpPaidTo (Tex) Sort: ® Mone  Ascending © Descending
] ExpProthdeth (Tex)
[] ExpReceipt (Text) d| Label:

ivalue: © Yes &
Edit View Selection Formula: Lt fealaze (& 5ES (€ [e

Default “ipiel

Form = "Expense tem" : "Expenseltem”

Hide Achvanced Options ] Cancel ‘ Back ] et

13. The Step 4 of 4 screen presents a summary of the changes. Click Next to continue
processing. Based on the complexity of the data selected, the process may take few
minutes.

Wizard Step 4 of 4

You have completed configuration for the following forms:
Expenseltern

It may take a few minutes to create the views and ML export file. Click Nextwhen you are ready to proceed.

Cancel ] Back ] W= ]

As mentioned earlier, for each form selected, a corresponding hidden view is created in the
Target database with the name “($nsgl<FormName=>)". You can view the view using the
Domino Designer. Additionally, a Cognos ReportNet Model XML file is written to your XML
export path. The Notes view and XML file are very tightly linked. If you are tempted to
modify the $nsqgl* views, you must also modify the XML file correspondingly. (This is not
recommended unless you have a full understanding of the complete process.)

17
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Data Modeler for Notes

14. The Summary screen summarizes the processing that has been completed. You may

print this screen by selecting the Print button. Click “Close”.

Summary

You may want to print the following information for reference:

Database:
View:

Package Name:

Processed:
Language:

Export XML File:

Connection Name:

Demo T&E Tracking (DM3ample.nsf on Local)
[§nsqlExpenseItem)

Cihtewph DemoTETracking. Xl
DemoTETracking

DemoTETracking

01/10/2006 1Z:21:58 PM

English

[y )

18
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15. Documents are written to the Data Modeler database storing your configuration.

Q Welcome I@ Workspace xl@iﬁ Data Modeler Test - Data Model... XI 'ifﬁ\n‘iew Wwizard xl ) Jerome Shart - Inbios x]

DATA MODELER Database | Processed

Data Modeler for Notes

F!Q!CMSE @New Databasze Wizard @* Settings @Change Server @F{egister'

| Y¥iew Name

Demo T&E Tracking

for Notes

At any point you may rerun the Wizard to fine tune your settings for a database already
processed by opening the database document and clicking “Re-run Wizard”. Each time the
Wizard is run, the XML is file is overwritten and re-attached to the Wizard document. The
attachment is an archive of the generated XML file. The actual XML file in use is coped to
the file structure.

Summary

Expenseltem

($nsolExpenseltem)

You may want to print the following information for reference:

Databhase:
View:

Package Name:

FProcessed:
Language:

Export XML File:

Connection Natme:

Demo T&E Tracking (DM3ample.nsf on Local)
[$nsqlExpenseltem)
Cihvtewpt Demo TETracking. xml
DemoTETracking

Demo TETracking

01/10/20068 12:21:58 PN

English

1’ Re-run YWizard '

Print

Close

19
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C. Set up an ODBC Data Source

Data Modeler for Notes

Install NotesSQL on the Cognos server that will poll data from the Domino Server. The
Cognos server also requires a Notes Client or Domino Server installation and a copy of the
Notes ID file that you intend to use to access data via NotesSQL. Restart the server before

continuing.

1. Go to the Windows Control Panel, open Administrative Tools. Data Sources (ODBC).

Click the “System DSN” tab and click Add.

2. Scroll down and highlight the “Lotus NotesSQL Driver (*.nsf)” item and click “Finish”.

Create New Data Source

Select a driver for which you want bo set up & data source,

& [ o
Micrazoft Access-Treiber [*.mdb)
Microzoft dB ase Diiver [*.dbf)
Microzoft dB aze Y'FP Driver [*.dbf)
Microzoft dB aze-T reiber [*.dbf]
Micrazoft Excel Driver [*.xlz)
Microgoft Excel-Treiber [ xlz)
Microgoft FosPro WP Driver (*.dbf)

bdiroenft ONRC Far Nracla
A I I

x|

< Bach q Firizh I

Cancel

3. Enter your Data source name exactly as you defined the Connection Name in the Wizard
step 1 field three. Enter any meaningful Description. Use the pull downs for Domino server
and Database to select the Notes database you used with the Data Modeler. Click
“Options”, then click “Add User”. Make sure that you specify the Domino Server by name. If
you do not see your server in the drop down list verify that you do not have multiple

notes.in files pointing to the Server.

ODBC Lotus Notes Setup x|

Change data zource name, description, server or database name.
Select a Motes user name and enter pour Motes passwond,
Then chooze OF.

Mate: The lists of Domino servers and databazes may take a moment.

0

[rata source name: TEtrack

Description: |TEtrack Cancel
Uzing Installation: C:\Program Fileshlotushnotes?

Dioming server: IAngadJSun & Saon =]
D atabase: IS&S\T&Etrack.nsf j Browse

Optionz x> 1)

0

20
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4. Click Options > Add User. Browse to the Notes ID file which has at least Editor access to
the database. Then click “Next”.

Add New User x|

MWotes5AL obtaing the user name from a Motes 1D, You can
zpecify an 1D file on vour local maching or on a netwark, drive.

1. Select a Mates |D file for Motes50L to uze. You may
@ browze or enter a path to the 10 file.

2 Wou may specify an 1D file on a network, drive by uzsing
an UMC path [far example: “AServer\SharediMotes.id).

3 Select Mext to cottinue, or select Cancel to abort and
return ko the previous dialog.

Please select the Motez ID file you want to make available to Maotes50L

C:\Prograri FileshLotuz\MotesThdatatids\people R avihars. id Browse ... I

< Back Mext » | Cancel |

5. Enter the Notes ID Password for the ID file. Click OK.

ODBC Lotus Notes Setup x|

Change data source name, description, server or database name.
Select a Motes user name and enter pour Motes passwond,
Then chooze OFK.

Mote: The liztz of Diomino servers and databases may take a moment,

Data zource name: ITEtrack

Diezcription: ITEtrack
Uzing Installation: C:%Program Fileshlotushnotes 7
Diarning server: IAngadJSun % Son j

Database: IS&S\T&Etrack.nsf j Erowse |
Options << |

— MotezSOL Options:
User name: ( avi Har Singh Khalsa/Sunar vy Add User ..
Pazsword: Clear Pazzword
taw length of text figlds: 254
Max length of nich text fields: 512
Return Motes implicit figlds: u
Map special characters: v
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6. Your Data Source will appear in the System DSN tab.

UserDSNFiIe DSH I Driversl Tlacingl Connection F'oolingl About |

Swstem Data Sources:

Hame | Diriveer | Add... |
CsDwPROD Bt DBZ ODBC DRIVER
MNotesSGL_PersMames  Lotus MotesSQL Driver (% nsf) RBemaove |
MNotesS0L_SampleDB  Lotus MotesSQL Driver (% nsf)

Lotus MobesSQL Diriver [ nsf] LConfigure... |

An ODBC Swster data zource stores infarmation abaout how to connect ta
the indicated data provider. & Spstem data source is visible to all users

on thiz machine, including MT services.

[ ox ]

Cancel | Sppl | Help |

Data Modeler for Notes

7. Click the Connection Pooling tab. Double click on the Lotus NotesSQL Driver and Verify
that connection pooling is disabled. DO NOT turn on Connection Pooling! Connection
Pooling it can cause Cognos 8 to become extremely unstable when accessing Notes.

§10DBC Data Source Administrator ] = 2| x|

IJzer DEM I Syztem D5H I File DSM I Driversl Tracing Connection Poaoling |.-i'-.l:u:|ut I

i Perfbd u:un-—l

— Connection Pooling Timeot
ODEC Drivers:

(4]

Set Connection Pooling Attributes

I amne
Drriver do Microzoft Paradaox [*.db ]
Diriver para o Microzoft Yisual FoxPro

Lotuz Makeetri=Frriverfrmok
% Dgn't pool conmections ba @

Cancel

x|
_ Concel |

BM DEZ2 ODEC DHNEH

bdicrosaft .-'f-.ccess Drwer [* mu:II:u]
Microzoft Access-Treiber [*.mdb]
icrozaft dB aze Driver [*.dbf)
Microzaoft dB ase WFP Criver [*.dbf]
Microzoft dBaze-Treiber [*.dbf]

{" Pool Connechions to thiz driver
Tirme that unuzed connestions rematn the pool

It seconds; ||3|:|

X

Connection pooling allows an application o reuze open connection
handles, which zaves round-trips to the server.

o ]

Cancel Apply Help
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D. Set up a Cognos data source

1. Before continuing, ensure that NotesSQL is installed on the CRN or Cognos 8 server, and
that the ODBC connection is configured. From a web browser on the Administrator’s
workstation, open Cognos Connection at http://<yourcrnserver=>/crn. Click the Welcome
page tab. Click the Directory link under Tools in CRN, in Cognos 8 Tools > Directory.

Note: Screen shots displayed here are from Cognos Report Net, Cognos 8 is slightly
different and some commands may only be available from the Menu instead of being
available on a Right click.

Wi cognos Connection

Welcome 1 Public Folders | My Folders

Welcome - Cogr

Cognos Connection allows you to publish, find,

View Reports B

Access pre-authored reports in the Public Folders tab,

Store and access vour Favorite reports in the My Folders tab,

Customize Cognos Connection

Click the Mews Page ﬁi button to create wour own personalized pages.,

Tools

The Following tools are available:

Preferences Personalize Cognos Connection, Specify display options, rec

Define data sources and their associated connections. Defin
namespaces, Specify distribution lists, contacts, and printes:

2. Click Data Sources.

i Directory
| Users, Groups, and Roles d Data Sources Distribution Lists and Contacts Printers
Directory
| bl |Name - |Modiﬁed E] Active
ﬂ Cognos June 10, 2005 5:57:26 AM W
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3. Click the New Data Source icon (cylinder) on the tool bar on the upper right of the
screen.

ﬁ Query Studio @ Report Studio
EDirectorv Return Home Preferences About Help

Users, Groups, and Roles | Data Sources | Distribution Lists and Contacts Prinkers

Directary > Cognos

1-4
& |Name a Modified 2 Actions

- D qosales June 25, 2004 5:29:45 PM Mare, ..

I D MotesSOL Sample March 15, 2005 2:57:48 PM More...

- D MotesSal Pershlames June 8, 2005 1:39:37 PM Mare, ..

I O Sample DEZ February 22, 2005 12:50:18 PM More...

4. Under Name enter the Connection Name exactly as you defined it in the Data Modeler.
Enter a meaningful Description or Screen tip if you wish. Click “Next”.

Specify a name and description - New Data Source Wizard

| Specify & narme and location For Ehis entry, You can also specify a description and screen tip,

Name:
[TEtrack]
Description:
[
=
Screen kip:
Location:

Directary > Cognos

Cancel Mewxt =
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5. Select ODBC (Windows only) option in the Type pull-down and click “Next”.

Specify the connection - New Data Source Wizard

| Specify the parameters for the connection of this new data source, Th

Isolation level:
* Use the default object gatewary

~ specify a value:
Cursor stability j

Cancel < Back Mext =

6. Under ODBC data source, enter the Connection Name exactly as you defined it in the
Data Modeler. Scroll down to the bottom of the screen and click the “Test the connection”

link.

Specify the ODBC (Windows only) connection string - New Data Source Wizard
| Edit the pararieters ta build an QDEC (Windaws anly) connection string.

ODBC data source:
[TEtrack]

ODBC conneck skring:

Collation sequence:

[T open asvnchronously

Testing

I: Tesk the conneckion, .. :‘

Cancel = Back Finish
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7. Click the Test button. You should see Succeeded in the View the Results — Test the

Data Modeler for Notes

connection dialog. If not, go back and verify that the Connection Name exactly matches the
name used in the ODBC configuration and that the ODBC connection is properly configured.
Click Close, Close again, and Finish. Your Data Source should appear in the list. Close the

Cognos Connection browser.

Test the connection - New Data Source Wizard

| Test the parameters that make up the database connection,

Connection skring:
SLOCAL; 0D DEM=TEtrack; @ASYNC=0@ 0/ 0@ COLSEQ=

Dispatcher:
hktp:ffravibar40: 9300

Close

View the results - Test the connection

e Mane Status
I'l:: . http:,l',l'ravihar4tl:93l]

Closea

Message
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E. Create a Project in Framework Manager and Publish the
ReportNet Package

1. Open Cognos Framework Manager. Click Create a new project.

Welcome - Cogng

Cognos Framework Manager allows

Projects

_reate & new project, ., Jse to create a new project,
e ———

Open a projeck. .. Use ta open and edit an existing project.

Recent Projects

| Name Location

2. Under Project name enter the Package Name you defined in the Data Modeler. Click OK.
When prompted to Select Language, select the default (English) and click OK.

New projeck ﬂ

Project name:

ITraveIExpenseTracking

Location:

IE: “Program Filez cognosicmwebcontent\samplegitodelz TravelE spenszeT racking E-l

Repository << |

— Reposzitary setting:

[ Add to repositony

Connection:

Location in repozitary:

1 Cancel | Help |

P

3. Select Cognos ReportNet Model under Select Import Source. Click Next.

Import Wizard - Select Import Source x|

'S —]
—i = -

Select Import Source:

[ Database

Cogros ReportMet Model
© Cognios Architect [ xmi]
[ | Cognos Irmpromptu [F.«ml)
& Cognos DecizionStream [*.xml)
Third Party Metadata Sources
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4. Click the Open Folder icon.

Import Wizard - Select Model

Select Cognoz Reportiet todel

5. Navigate to Data Modeler output files. (The default is C:\temp in less it was changed in
Step B 2) Select All Files (*.*) under Files of type so that XML files will be displayed. Select
the XML file with your Package Name and click Open. You will see your file path under
Select Cognos ReportNet model. Click Next.

RI=IE
J File | Edit  View Favorites Tools  Help | 1','
J L Back ~ £ ~ [f | - Search [~ Folders | [& @ X &) | -
Mnddress IEJ i Temp j
| Sizel Type | Date Modified
20KE =ML Document 6152005 10:31 AM
4| |+
|Type: %ML Document Date Modified: &§15/Z005 10:31 AM Size: 19.7 KB 19,7 KB | rj My Computer 5
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6. Check all displayed objects and click Next.

Import Wizard - Select Objects

[t}
[vIQ@l Feservation
_u Travel Autharization

Import Wizard - Finish
]
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8. In Project Viewer, highlight your Data Source. In the Properties area, verify that Query
Processing is set to Limited Local. Type ctrl-S to save your project.

| Project Viewer a x|
EI--@ TravelExpenseTracking
TravelEspenseTracking
EI@ Data Sources
“{] TEbrack
[Fq) Parameter Maps

@I TravelExpenseTracking

TravelExpenseTracking

i= Object Explorer 3= Object Diagram

Data Sources

Parameter Maps

Packages

Properties  Languages

Name TEh =
Query Proceszing El
Rollup Processing | ung

Content Manager Dat TEtack

Catalog
Cube
Schema

Type

9. Right click your data source > Test Data Source.

| Project Viewer

O x|

TravelE spenzeT racking
=) Data Sources

B | aals

Parar

E--@ TravelExpenszeTracking

Create Relationship

@ TravelExpenseTracking

% TravelExpenseTracking

o Pack.:

Locate In Project Info

—
=

i= Obijeck Explorer 3 Obijeck Diagram

Data Sources

[l

Copy
Paste
35 Delete

D —

CErl+i

Chrl+C E

CErl+Y

Parameter Maps

Packages

Rename

Create Shortcut

Del @

Select All Similar Ohjecks
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You should see that the data source was tested successfully. Click “OK”. If the test is
unsuccessful refer to the Troubleshooting guide in the Data Modeler Best Practices

documentation.

== TEtrack - Framework Manager x|

,-'fl The data source was tested successfully.
.

10. In the Project View, expand your Model. Right click on the first Query Subject and

select “Test Query Subject”.

| Project Wiewer

TravelEspenzeTracking
=

=

E F Creake
HgEE T Mew Parent

[y Data Eﬂ Create Relationship
Byl Parar

i Pack Locate In Project Info

Context Explorer

Edit Definition. .,

Specify Dimension Information. ..

Update Query Subject

Merge in Mew Query Subject
Detect Relationships. ..

ko ok L.

0 x|
EI--@ TravelExpenseTracking @ TravelExpenseTracking

TravelExpenseTracking

i= Object Explorer 8= Obiject Diagram

Data Sources

Parameter Maps

Packages

11. Confirm that the Test Result displays valid data. Click Close and repeat for each Query
Subject. If successful, you have verified that the data source and connections are properly
configured. If the test is unsuccessful, refer to the Troubleshooting guide in the Data

Modeler Best Practices documentation.

x
b E
Test result -
AuthMum | ExpMum | Lmount | HIDDEME spémount | ExpCity | Expliate
TOOO445  EOO3F3E 582 582 Albuguerque E/24/2004
TOOO445  EOO3F39 642 E.42 Dallas E/24/2004
TOOO445  EOO3Z40 30 a0 Cambridge E/24/2004
TOOO448  EOO3341 27 27 Cambridge E/27/2004
TOOO448  EOO3342 4982 B4982 Cambridge E/27/2004
TOOO448  EOO3343 15 15 Mew Tork E/27/2004
N TOO0448 EOO3344 1155 11[55 Mew Ttk B£28£2DD4LILI

Test Result | Fiesultz Infarmation |
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12. Right click on the Packages item and click “Create”, “Package”.

| Project Viewer

O x|
EI--@ TravelExpenzeTracking @ TravelExpenseTracking
TravelExpenzeTracking
ﬁl Data Sources

+-(Fy) Parameter Maps TravelExpenseTrackin
(o TE—— P 9
§8l Package bieck Explorer 3= Obiject Diagrarn
Create Relationship
_ r'l Data Sources
Locate In Project Info

Specify Package Languages.., | &=
== | Parameter Maps
Explare Packages. .. EE

Publish Packages. ..

Cut Chrl+x -' PRIZHE gk

Copy Chel+C
Paste ChelY

[or iy [y S [ |

13. Under Name enter your Package Name as you identified it in the Data Modeler. Click
“Next”.

Create Packag - Provide Name / @] é

55 " Na
SHN (G .
Marme:

ITraveIE spenzeT racking

Drescription:

Screen bip:

Help Cancel < Back: { Mest > 1 Eiriishy

P
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14. Ensure that all objects are checked and click “Next”.

Create Package - Define objects

— = R
F;_f_,‘fj 3 \[j] L

gL

[efine the objects you want to include in this package
= Using existing packages

' From the project

| TravelExpenseTracking
W | Esperize ltem

- o |~ | Qi Freservation
[ Travel Authorization

Help Cancel ¢ Back ‘] Finish |

P

Data Modeler for Notes

15. Click Next in the Add Security dialog. In the Select Function Lists screen, click Finish.

Click Yes in the success notification dialog.

.:: TEtrack - Framework Manager x|

.3 Tou have successfully created your package.
Would you like to open the Publish Package wizard?
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16.

Data Modeler for Notes

In the Select Location Type screen, uncheck Enable model versioning. Click Publish. If

you receive a message warning that your existing package will be overwritten, click Yes. If
you receive a message warning that the administrative access list is empty, click OK.

Publish Wizard - Select Location Type
I J

X
=
L] n;

o

— Select publizh location
" Cognos Reparthet Server
[~ Enable model versioning

Humber e mode] wersions ta retai (enten 0 hen unlinited versions]

E
[T Delete &l previous modelversions
 Location on the netwark

ebwark location:

IC:'\Documents and SettingsiRavihar SUMANDS OMYy Documentsh T ravelE «pe

— Externalized query subjects

[ Generate the files for externalized query subjects

ebwark location:

IC:\Documents and Settingz'Ravihar SUMAMDS QMY Y Documents

[~ “erify the package before publishing

Click Publish to publish your package.

< Back Publish

Help |

Cancel |

e

Z

17. At the finish screen, click Finish. Close Framework Manager

E- \ I..._.i.: ~
=N <55

x|
=

N
N
w

You have successfully published the package to the following location:
Public Folders » TravelE=penzeT racking

Do you want o
(%" Exit this wizard
” Publish anather package

Your Data Model is now complete. You are now ready to start generating reports.
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F. Create a Test Report in Query Studio

1. From a browser on the Administrator’s workstation, open Cognos Connection at
http://<yourcrnserver=/crn or http://<yourcrnserver=>/c8. Click the Query Studio link.

Query Studin &Report Studio

@Cognos Connection Home Preferences ahouk Help

Welcome 4 Public Folders | My Folders Tools

Welcome - Cognos Connection

Cognos Connection allows you to publish, find, manage, and view your organization's reports.

View Reports Create Reports

Access pre-authored reparts in the Public Use Query Studio bo create simple ad hoc
Folders tab, queries,

Store and access wour Favorite reports in the |Use Report Studio ko create more advanced
My Folders kab, business reports,

2. Click the link to the Package you published in Framework Manager.

Select a package

| Select which package to use bo create a new repart.

| Name
CRH TE View
GO Model
50 Sales and Retailers
Iy First packane
MokesSOL Sample
Sample

Sample DBZ2

{' : TravelExpenseTracking >
T
e ———

Cancel
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3. Expand the Package and expand the first Query Subject. Drag the Query Subject
(Expense Item in this example) into the central work area.

i Query Studio - Mew

Menu

| Insert Data

Edit Data
Change Lavout
Run Repart
Manage File

TraveIExp.enﬁai\'!ﬂd/ng
= EXpEREE e

frn]

§ll Reservation
1

-gEE Travel Authorization

ﬁ Expense Ibem

[ DHE & BXova p T Z

]

Title

4. Verify that all data elements are displayed correctly. Click the Undo button and repeat
steps 3 and 4 for any additional Query Subjects.

L ey = o - e

e

4]

lieerl Cola

N
Teree cunn
Zu1 Eanyl

~57a3=Me

ﬁ'ﬁ"r. wiFsp sra Tw g
:.I'ﬁ Feamran he—
! O ']] antla =
P -WFrHm
: }'ﬂ Aol
My
]]E:Ll:ux
- Wl pusesre
Y [y
HE pese-azten
+k m | e g b Eazon

[TH = %

uthium ks

[URIE L= = B
[URIEE T . Eor
W EU_ZM]
TOC0d=D COZasM.
TOC04-0  COZlaz
TOC04-0 COZ3D
TOC0d=D COZ3H4
TOC04=0 COZ3sHE
TOC04-0 COZ3adE
ooz E0ZEIAT
ks FTAHR
= FATATHY
k= FRTATET
s FNTATE
LI T o e il
(LI TE A ) B B
W= EU_ESA 4
W) NSNS
[UIIE S L. E i
W) BN A

Areout
Foake
Fo4:

oA
=20
$E=a 0z
=150
=1_3=
=130
pz2a =
£23 52

7o

F1 T
13T
<1 01--
R
6 L
FlaA
F1o A
Suld L

ECWET
BXao b T TE M == F e m
Tide
Lty Expliate ExpLESCrip ExpHaid o

nlucuscus | Jare 24 sUoe beashfzes 2lsck ez

L5 Jars 24 U Lach rg Lo -an

vsrvbodze  Jara 24 LUl lam

Csrbodze 32T Z0Z- Tasl

Csrbrdze 2z 27 Z0Z- Carrbeldge Maiot skt

Pt I 1z 2T Z0Z- chode Zuzer “he ke

PEW TF 1r= 21 Z02= Tren w1 Trensh

M Wr Jr=2 20 Z02= Ta:=l

bt Yr 1=z 22 Z0Z= MHerrlzE vErrict

kol o222 Z020 T Sarie L

[ T Tr 225207 Boari | Yoara |

[ H Tr 2507 1 rah ant r 2

[ H 1r 'L 507 (1 rih B AR TR

Abmarrany Tr 20507 Al Pk sarirlFeilal:

EY BUNTE (NTIRN I RS I R M T B -

AltvnErvna T dd Ll ey bt

Jara 23wl | MEC Tod 2 crns

FEw 12 Lk 21 204 sS ok rouac-T polight U1 e Ueied bz

Mew (20 Juab 20 204 Bk oSS rouac-T poAigtt U1 o Ut bz

MNEw (2% Jab 21 204 Las fronr Bk b -oks

h Crore Cnnerin 35 I
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5. You are now ready to start creating professional reports from your Notes data using
Cognos Query Studio and Cognos Report Studio. Please refer to Cognos ReportNet or
Cognos 8 documentation to get started and fully utilize these powerful tools.

m Cognios Connechion @ Report Studio
[ Query Studio - New Retwrn About Help

Menu MDQ@%XK"WDV%’E IZ lIIZII(_

Insert Data | Title

| v

Edit Data
Change Layout AuthMum  ExpDate City ExpPaidTo ExpDescrip Amount  ExpNum
Run Repork TOOD442  June 24, Albuguerque | Black Mesa Breakfast $5.82 E003932
Va e e EIL Cambridge Taxi $30.00 EO03940
EVE'EXDEHSETW“HG Dallas subon Pain - Lunch $5.42 EO03939
=[Ol Expense Item
$42.24
i Authlum
[ Exphium June 27, Cambridge  Marriott Carmbridge Marriott $549.82 E003942
EL amourt s Cambridge Taxi $27.00 EO03941
(W] ity e rark Super Shuttle  Shuttle $£15.00 EO03943
[l Exphiate $591.82
W Exppescrip June 28, Mew York | Marriott Marrictt $229.25 ED03946
[l ExpPaidTo 2004 3 .
. Mew viork M1 Transit Train $11.55 E003944
10 Reservation Mew rork Taxi $12.00 EO03945
e Yo ai .
-JJ0 Travel Autharization
Mewark Marriott Dinner £20.65 E003947
$279.45
Jure 29, Albuguerque  AirportFastpark  Alrport Parking $18.00 EO03951
EIL albuguerque  Fei Dirrer $10.83 EO03052
&lbuguerque Trip to ABQ $47.45 EO03953
Dallas AL bon Pain Lunch $£7.50 EO03249
Dallas Starbucks Lunch $4.71 EO03950
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G. Enhance the Data Structure in Framework Manager

This section illustrates one of the powerful capabilities of data modeling using Framework
Manager, the ability to join Query Subjects. In the example using the sample Travel
Expense database, we have created reports which merge data from Travel Authorizations
and Expense Items. If done directly in Notes, this feature would require a significant
modification to the data structure.

1. Start Framework Manager and click the link for the Project we created, in this case
TravelExpenseTracking.

Welcome - Cognos Framework Manager

Cognos Framework Manager allows you to model metadata and publish packages.

Projects
D Create a new praject. .. Use ko create a new project,
Open a project. .. Use to open and edit an existing project.

Recent Projects

MName Location

TravelExpenseTracking ¥ C:\Program FilesicognosiorniweboontentisamplesiModels! TravelExpenseTracking!, TravelExpense Tracking, cpf

2. Click the Object Diagram link under TravelExpenseTracking in the center panel.

J 4=mEack  cFarward | 1 ? |TravEIEﬂ:penseTracking

| Project Viewer O x|
= @ TravelExpenseTracking % TravelExpenseTracking

El . TravelE:-:penseTrau:kmg
- ilﬁ Expenze [kem
B {li Reservation % TravelExpenseTracking
- @ Travel Autharization

I [E_‘| Data Sources

17 Parameter Maps

(@) Packages Data Sources

=] Parameter Maps

= Objeck Explorer 59

Obieck Diagram

I Packages
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3. Displayed is the Data Model as an entity relationship model. Note that several data
element names are prefixed with ‘HIDDEN’. These elements were created by the Data
Modeler. Since NotesSQL shows all data from Notes Views as string data type, the Data

Data Modeler for Notes

Modeler hides these values and exposes newly computed elements of the correct data type
for numeric and date fields in Notes.

We have moved the Query Subjects around on the screen by dragging them by their title

bars.

| Project Viewer O x|

E--@ TravelEspenzeTracking
E| TravelExpenseTracking
Eﬁ Expenze ltem
== .
Qi Fezereation
ﬁﬁ Travel Suthorization
({31 Data Sources
£y Parameter Maps
-3 Packages

TravelExpenseTracking

AuthMunm

TrvCost
HIDDEMTrvCost
TrvDateEnd
HIDDEMTrvD ateEnd
TryD akeStart
HIDDENT rvD ateStart
TrvDestinations
TrulMames
TrvPurpose

) ResvPrice

AuthMum

ExpMum

Arnatint

HIDDEME =pésrnount
Citw

ExpD ate
HIDDEME #pD ate:
ExpDescrip
ExpPaidTo

AuthMum
E=pCity
ResvConfMum
FezvDateBeqin
HIDDEMResvDateB eaqin
ResvDateEnd
HIDDEMResvDateE nd
Fesviames

ResvMum

4. AuthNum is a common data element to all three tables. Since we placed this element at

the top of each list and sorted it, it will act as a index value. We will be creating join
relationships from the Travel Authorization table to the Expense Item and Reservation

tables.

Right click on the AuthNum element in the Travel Authorization table and select Create
Relationship. (In Cognos 8 this is not available on the Right click, use the menu options

instead.

TravelExpenseTracking

3

uthMum

wpMum
raunt
|IDDENE xpémount

Set Focal Point
Expand

Collapse

HIDDEME »pD ate
F vpD escrip
EupPaidlo

Format. ..
Merge in Mew Query Subject
Determine Aggregation Rules
Dekermine Usage

E Verify Selected Objects. ..
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5. Click the Open Folder icon above the empty Query subject box on the right.

Relationship Definition - New Relationship ﬂ

Relationship Expression | Felationship SOL I

Mame:

INew Relationship

Qe subject; Query subject:

|T ravel Authonization El Mew Link | I

Authium

TrvCost
HIDDEMTrvCost
TreDateEnd
HIDDEMTrvDateEnd
TrvDateStart
HIDDEMTreDiateStart
TreDestinations
TreMames
TrvPurpoze

Cardinality Operator Cardinality

1.1 - = . 1.n -

6. Select Expense Item and click OK.

Select Query Subject ). il
Awailable iterns:

E|. TravelEspenseTracking
=- I B tem
-l Resereation

Ok I Cancel
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7. You will see that Framework Manager created a relationship between AuthNum in the

Data Modeler for Notes

Travel Authorization Query Subject and AuthNum in the Expense Item Query Subject. We

have modified the relationship to be 0...1 on the Travel Authorization side. Note that the
operation of the relationship is explained under Relationship impact. Click OK.

Relationship Definition - New Relationship

Relationship Expression | Relationship SOL I

Mamne:

INew Fielationship

(e zubject:

Cuery zsubject:

|Travel Avtharization [E‘“;l Mew Link | |E:-:|:-ense Item E-l
N = =
TrvCost ExpMurm
HIDDEMT rvCost Aot
TrvDiateEnd HIDDEME spdmatint
HIDDEMT rvDateEnd City
TrvDrateStart ExpDate
HIDDEMT D ateStart HIDDEME=pDate
TrvDiestinations ExpDescrip
TrvMames ExpPaidTo
TrePurpoze
Cardinality Operator Cardinality
0.1 |hd = A l.n ™
| pp—
Relationzhip impact: Each Expenze [tem has zemo or one Trawvel Authorization [outer join].
Each Travel Autharization has ane or mare Expenze ltem.
Expression;

Travel suthorization AuthMum = Expenze lbem.AuthMum

o |

Cancel

Help
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8. The relationship is shown on the main Framework Manager screen. Repeat the process
to create the same relationship between the Travel Authorization and Reservation tables.

| Project Viewer O x|

E"@ TravelkspenseTracking TravelExpenseTracking
TravelExpenseTracking

-[fy Data Sources

Pararnzter taps

B-(@) Packages Authhurn

HIDDENTrvCost

AuthMum

TreDateEnd HIDDEME #pérmount
HIDDEMT rvDiateEnd o 1. | Citw

TrvDateStart ExpD ate

HIDDEMT rvD abeStart HIDDEME xpD ate
TrvDestinations ExpDescrip
TrveMames E=pPaidTa
TrvPurpose

AuthMum
E=pCity
ResvConfiurm
FesvDateBeqin
HIDDEMR exvD ateB aqin
FesvDateEnd
HIDDEMR esvD ateEnd
ResvMames

RezvMum

ResvFrice

9. When both relationships are set, expand Packages in the Project Viewer. Right click on
the TravelExpenseTracking package and select Publish Packages.

Pra ]

E--@ TravelE spenzeTracking
EI TravelExpenseTracking

B Experse ltem

== .

I Feservation

- Travel Authorization

-[f]) Data Sources

: Fararmeter Maps

TravelExpenseTracking

AuthMunm
TrvCost
HIDDEMTrvCost
TrvDateEnd
HIDDEMT rvDrateE nd 01

AvthMum

HIDDEME spernount
City

TrvDateStart ExpDate
) ) ateStart HIDDEME#pD ate

Create Relationship = ExpDesciin
- ExpPaidTo
Edit Defiriition. ..

Specify Languages. ..

Edit Package Access...

Analyze Publish Impact. ..

Specify Package Function List...
Pl Prublish "

; ; ResvConfhum
E Werify Selected Objects... FesyD ateBedin
HIDDENResxvD ateB eqin
Zuk Chrl4 ResvDateEnd
- HIDDEMRezvD ateEnd

oy Ctri+C ResvMames

Paste Chrl+y AesvMum

ResvPrice

¥ Delete Del

Create Sharkeut

Rename

Select Al Similar Objects
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10. Click Publish at the Select Location Type screen.

Publish Wizard - Select Location Type 5'

f : .J - N

— Select publizh location
' Coghos Feporttet Server
[~ Enable madel versioning
Humber af model wersions taretai [enten 0 fen unlmited wersions] -
[

[T Delete Al previous madel versions

" Location on the nebwork

IHetwark lozation:
IC:'\D acurments and Setingzi B avibar SUMANDSOM WMy DocumentzTravelE xpe

— Externalized query subjects

[~ Generate the files for extemnalized query subjects

I ebwrk [ocation;:
IC:'\Documents and SettingsRavihar SUMARND S 0N My Documents

[~ “erify the package before publishing

Click Publish to publish your package.

Help | <Back [ Publish )| Cancel |

e — S

11. Click OK when you are warned that the package already exists. If you see another
warning that the administrative access list is empty, click OK again. Then click Finish.

-m TravelExpenseTracking * - Framewark Mar T |

&4 package already exists with the name(s):
TrawvelExpenseTracking - English

Publishing will overwrite the current model in the package.

Do you wish to publish this package?
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12. Press <control> S or save button to save your project and close Framework Manager.

13. Open Cognos Connection and launch Query Studio. Select the TravelExpenseTracking
package. Expand the Travel Authorization Query Subject, select the AuthNum and
TrvDestinations Query Items and drag them into the workspace.

[ Query Studio - Mew

Menu mDH@xExnﬂbvétz

’-Tsert Data | Title
Edit Data

Change Layout
Run Repart
Manage File

TravelExpenseTracking

-Jill Expense Item (] Authhum
m i |I| TrvDestinations
E--J§l Travel Authorization

() e
@ TrvCast

|I| TrvDateEnd
|I| TrvDateStart
| Trvpestinations
|I| TrvMames
|I| TrvPurpose

14. Now expand the Expense Item Query Subject and drag the ExpDate Query Item to the
right of TrvDestinations in the workspace (the right border of that column will be
highlighted). Now do the same with the ExpDescrip and Amount Query Items.

[l Query Studio - New

Menu
rﬁrt Data
Edit Data
Change Layout AuthWum  TrvDestinations

Run Repark TOOD447  Germany
IManage File TOOO448

[ DEHB@E & B Xna p T3
| Til

Cambridge

TravelExpenseTracking TOOO450 | Mew York H| ExpDate
E1-{iil Expense Item

TOOD0451  Cambridge
""" |I| AuthiMum
_____ ] Exptiam TOOD452 | Buffala
..... B Amaunt TOOD452  London
----- (|l city TOOO454 | Buffalo
""" [ Etpatd TOOD455 | Cambridge
""" [l Exprescrip TOOO456 | Mew York;Cambridge
__ Wexppadro TOOD457 | Orlanda
[+ g Reservation
TOOD452  Las Yegas

=g Travel Autharization

..... ] Awthiium TOOD459 | Ottawa

..... [ Trvccost TOOO460  Boston;Mew Yark

----- [l TrvDateEnd TOOD461  Albuguerque
querg

----- [W] Trubiatechart Tonnasn e
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15. Select the column headers for AuthNum and TrvDestinations. Click the Group icon on
the toolbar.

[ Query Studio - Mew

Menu

q DE& & &Xea b 7

| Insert Data

Edit Drata
Change Lawaout
Pun Repaork
IManage File

TOOO443

B

TravelExpenseTracking
=il Expense Item

""" i Aukhhum

""" &F\mount
..... i city

""" i ExpDate
""" i ExpDescrip
""" i ExpPaidTo

|- [l Reservation

=i Travel Authorization

""" i Aukhrurn

""" ﬂ,Terost

""" i TrvDateEnd

""" i TrvDakeStark
""" i TrwDestinations
""" i TrwMames

""" i TrwPurpose

TOO0443
TOO0448
TOOO448
TOOO443
TOO0448
TOO0448
TOOO448
TOOO443
TOO0448
TOO0448
TOOO448
TOOD443
TOO0448
TOO0448
TOO0450
TOO0450
TOO0450
TOO00450

rvDestinations

Carnbridge
Carnbridge
Cambridge
Cambridge
Carnbridge
Carnbridge
Cambridge
Cambridge
Carnbridge
Carnbridge
Cambridge
Cambridge
Carnbridge
Carnbridge
Cambridge
ey Yark

ey Yark

Mew York

ey Yark

ExpDate
June 24, 2004
June 24, 2004
June 24, 2004
June 27, 2004
June 27, 2004
June 27, 2004
June 28, 2004
June 28, 2004
June 28, 2004
June 28, 2004
June 29, 2004
June 29, 2004
June 29, 2004
June 29, 2004
June 29, 2004
June 29, 2004
July 11, 2004
July 11, 2004
July 16, 2004
July 16, 2004

m Cognos Con

im {5
Title Group
ExpDescrip
Breakfast
Lurich
Taxi

Cambridge Marriott

Shuttle

Taxi

Dinner

flarrioth

Taxni

Train

Ajrport Parking

Dirner

Lunch

flarriott

it food & drink

Trip to ABQ

AUS o EWwR round-rip flight 07/11 to 07/23
Taxi from EVWR 1o hotel

EVWR to AUS round-trip flight 07/18 o 07/22
My Marriott Marquis

Amount
$5.82
.42

$£30.00
$549.82
$£15.00
£27.00
£20.65
$229.25
$£18.00
$£11.55
£18.00
£10.83
$12.30
$141.25
£35.00
$£47.45
$505.90
$60.00
$511.90
$975.80
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16. Select the ExpDate column by clicking the column header and click the Group icon.

[ME Query studio - Hew

Menu

 DEHRE & BXwnao p 7z

Insert Data

Edit Data
Change Layout
Run Report
Manage Filz

TravelExpenseTracking
Eﬁﬁ Expense Item

-] authium

i Exphum

a, Amaunk

(W] city

i Explate

i ExpDescrip
-} ExpPaidTa

[]"'ﬁﬁ Reservation

ElJ§l Travel Authorization
-l Authium

ﬂ, TrwiCosk

i TrvDateEnd

i TrvDatestart

i TrvDestinations

i TrvMames

i TrvPurpose

AuthNum TrvDestinations

TOOD448

TOOD450

Cambridge

Mewy vork

ExpDate

June 24, 2004
June 24, 2004
June 27, 2004
June 27, 2004
June 27, 2004
June 28, 2004
June 28, 2004
June 28, 2004
June 28, 2004
June 29, 2004
June 29, 2004
June 29, 2004
June 29, 2004
June 29, 2004
June 29, 2004

July 11, 2004
July 11, 2004
July 16, 2004
July 16, 2004

m Cognos Conmne

Title
ExpDescrip Amount

Breakfast £5.82
Lunch 6,42
Taxi £30.00
Cambridge Marriott £549.82
Shuttle £15.00
Taxi £27.00
Dirner £20.65
Marriott £229.25
Taxi £18.00
Train £11.55
Airport Parking £18.00
Ditner £10.83
Lunch £12.20
Marriot £141.25
Misc food & drink £95.00
Trip to ARG £47 45

$1,228.34

$1,228.34
AUS to BWR round-rip flight 07/11 o 07 /23 £505,90
Taxi from EWR o hotel 60,00
EWR to ALS round-trip flight 07/18 to 0722 $£511.90
MY Marriott Marguis £975.20
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17. We have quickly created a simple report which demonstrates how easy it is to merge
data from different document types. The same approach can be used to merge data from
different Notes databases or from Notes and relational data sources.

m Cognos Conr
[ME Query studio - Mew
- q DER (&@X oo b [Tz ==l
rﬁrt Data | m
Edit Data
Change Lavout AuthNum  TrvDestinations  ExpDate ExpDescrip Amount
Run Report TOO0D4483 | Cambridge June 24, 2004  Breakfast £5.02
Manage File Lunch $6.42
o el 000
""" 0] authrum )
_____ f] Exphium June 27, 2004 | Cambridge Marriatt $£949.82
..... B amount Shuttle $15.00
----- Hl city Taxi $27.00
""" Wl Exppate $591.82
""" W/ expescrip June 28, 2004 Dinner $20.65
E:i ExppaidTo Marriott $229,25
[]"'E Reservation Tax St
=@l Travel Sutharization
..... B Authium Train $11.55
..... Bl rrvcost $279.45
----- | TrvDateEnd June 29, 2004 Airport Parking $18.00
""" i TrvDateStart Dinner $£10.83
""" i TryDestinations Lunch $12.30
jjjjjg renes. Merriot $141.25
Misc food & drink $585.00
Trip to ABQ 47,45
$314.83
$1,228.34
$1,228.34
TO00450  Mew York July 11, 2004 AUS to EWR round-trip flight 07/11 to 07/23 $505.90

18. Now is a good time to further explore the capabilities of Query Studio and Report
Studio. The Travel Expense data model we have created is available to any reports you
want to create.
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